Cascade Server

Level I
Table of Contents

Chapter 1   Introduction.................................................................................................................. 5
  1.   General Terminology ........................................................................................................... 5
  2.   Planning ............................................................................................................................... 6
      A.   Basic Planning Steps ........................................................................................................ 6
      B.   Creating effective content and web pages ................................................................. 6
      C.   Helpful Resources on Web Content ............................................................................. 7

Chapter 2   Templates....................................................................................................................... 8
  1.   Cascade .................................................................................................................................. 8
  2.   Template & Layout Overview ............................................................................................... 8
  3.   Staging Website .................................................................................................................... 9

Chapter 3   Getting Started............................................................................................................. 10
  1.   Location & Login .................................................................................................................. 10

Chapter 4   Cascade Interface ....................................................................................................... 11
  1.   Sites Drop Down .................................................................................................................. 11
  2.   Side Bar Toggle Icon ............................................................................................................ 11
  3.   Base Folder List ................................................................................................................... 12
  4.   Reordering folders .............................................................................................................. 13
  5.   Top Navigation Bar (Home, New, History, Tools) ............................................................ 13
  6.   Asset tabs (static) ............................................................................................................... 14
  7.   Secondary tabs (dynamic) .................................................................................................... 14

Chapter 5   New Pages ................................................................................................................... 15
  1.   Creating a New Page ............................................................................................................ 16

Chapter 6   The WYSIWYG............................................................................................................. 18
  1.   Using the WYSIWYG ........................................................................................................... 18
  2.   Adding Hyperlinks ............................................................................................................... 19
  3.   Applying Headings ............................................................................................................. 19

Chapter 7   Changing Banner Images .......................................................................................... 20

Chapter 8   Uploading Files & Creating Folders .......................................................................... 22
  1.   Uploading Files .................................................................................................................... 22
      A.   Upload a File: Drag and Drop ...................................................................................... 22
      B.   Upload a File: Browse .................................................................................................. 23
  2.   Creating Folders ................................................................................................................... 23

Chapter 9   Quick Links .................................................................................................................. 25
  1.   Unique Quick Links ............................................................................................................ 25
Chapter 10  Events ............................................................................. 26
  1. Predefined Events Folder ......................................................... 26

Chapter 11  Faculty-Staff Bio Pages .................................................... 28
  1. Predefined Faculty & Staff Folder ............................................. 28

Chapter 12  Email Forms ................................................................ 30
  1. Predefined Email Form .......................................................... 30

Chapter 13  Correcting Mistakes ......................................................... 32
  1. Deleting ............................................................................. 32
  2. Using Versions ................................................................ 33
  3. Accessing the Recycle Bin .................................................... 33

Chapter 14  Publishing Your Site .......................................................... 34
  1. Publishing whole site .......................................................... 34

Chapter 15  Other ............................................................................ 35
  1. Google Analytics ............................................................... 35
  2. Copyright ........................................................................ 36

Chapter 16  Getting Help ................................................................. 37
Chapter 1  Introduction

1.  General Terminology

**Computer Network**  A system in which computers are connected so they can share information. There are millions of networks around the world.

**Internet**  The Internet, or Net, is the global collection of computers that carries data and makes the exchange of information possible.

**WWW**  The World Wide Web is a subset of the Net. It is a collection of interlinked documents. Also known as the Web.

**URL**  Uniform Resource Locator. A standard way of specifying the location of an object, typically a web page, on the Internet. URLs are the form of address used on the World Wide Web. They are used in HTML documents to specify the target of a hyperlink which is often another HTML document (possibly stored on another computer).

Example:  http://www.uregina.ca/index.html

**Browser**  A browser is a program that displays web pages. Some common browsers are Mozilla Firefox, Google Chrome and Internet Explorer.

**Website**  Websites are the places you visit as you make your way around the WWW such as “http://www.uregina.ca”. Sometimes websites are referred to as “home pages”. They may consist of a single page or many pages.

**Web Page**  A web page is an individual file that makes up part of a website. Web pages contain the text, pictures, and other content you see when you visit a website.

**Home Page**  This is usually the “starting” page for your website. This page must be named index.htm or index.html to be accessed automatically.

**Hyperlink**  Hyperlinks are words and/or pictures on a web page that when clicked take you to another location, page or site.

**HTML**  HyperText Markup Language. The standard programming language for creating web pages.

**HTML Tags**  Tags are the basis of HTML. Tags define how web pages look and allow web browsers to interpret them so you can see them. A tag consists of a "<", a "directive" (case insensitive), zero or more parameters and a ">".

Example:  <TITLE>The University of Regina</TITLE>
2. Planning

People skip this step because they don’t understand the importance of it. Planning a website is like planning to build a home.

A. Basic Planning Steps

These basic steps will help you plan your site:

- Define your target audience and gather requirements about your users and the content they need to find, or the tasks they need to complete on your website.
- Take an inventory of the content on your current site to identify what you have, the location, and what you want to keep, delete, or revise. This will help you identify content that needs to be created and develop a content plan for your new site.
- Organize your content and materials into a site map (or information architecture plan) based on your users’ needs and the information they need to find, or tasks they need to complete on your site. This will provide the basis for the directory structure of your site.
- Create a sketch of the page(s) you intend to create while considering the templates and predefined layouts the U of R provides. Select the template and layout option that best suits your content.
- Complete a Migration Guide of your new site structure, if you are preparing your site to be moved into the new templates and content management system.

B. Creating effective content and web pages

There are some basic tips for creating effective, eye-catching web pages:

- You have only a few seconds to grab your reader’s attention.
- Keep filenames short and be consistent. Make the title short, catchy, descriptive, and accurate and make sure it fulfills its promise. If you call your page “Thousands of Yummy Recipes”, it should be that.
- Provide clues at the top of the page about what the page contains; don’t expect anyone to scroll down.
- If your page is longer than three “screenfuls,” break it up into more than one page.
- Write in the active voice and in small content sections containing 5-9 pieces of information.
- Use labeling, bullets, and lists to help make information more scannable.
- Avoid the use of acronyms which do not show up in search engines.
- Balance is key. Don’t let your page design get lopsided. Balance white space, large and small images, different shapes, and blocks of text to give your page interest and variety.
- Don’t overload your page with extraneous information; only include relevant content.
- Be sure that anything that looks like a button behaves like one.
- Don’t create two links with the same name that go to two different places, or two links with different names that go to one place. Always offer a way back from one link to the originating page if the link is within your site.
• Make sure your links are descriptive; avoid the generic “Click Here” which is not intriguing.
• Use thumbnails as links to larger images.
• Remember that people will access your pages using different browsers that have different capabilities.
• Tell people the size of any downloadable files you include.
• Get permission to use text or images created by someone else.
• Avoid posting material created for the print world as PDFs on websites. Consider revising the content and posting as web pages.
• If posting a PDF or any downloadable file, tell users the size of the file and use an icon to signal the type of file. For example, when you post content as a PDF, place the file size in brackets after the file name, followed by the PDF icon.

C. Helpful Resources on Web Content

• Kristina Halvorson, Content Strategy for the Web
• Janice Redish, Letting Go of the Words: Writing Web Content that Works
• Louis Rosenfeld & Peter Morville, Information Architecture for the World Wide Web
• Jared Spool, http://www.uie.com
• Jakob Nielsen, http://www.useit.com
Chapter 2 Templates

1. Cascade

The University has chosen a content management system called ‘Cascade Server’ which is made by Hannon Hill. This is a web-based product which does not require users to install software.

2. Template & Layout Overview

The University currently has a variety of core templates for creating pages. The image area in the top half of each template becomes progressively smaller as the content area in the bottom half becomes larger. The templates for Faculty and Administrative units are the same except that Faculty templates have a colour bar that is unique to that Faculty as well as a location to display the Faculty logo if desired.

The core templates include:
- Level 1 – usually used for faculty pages or top level administrative units (Example: Information Services)
- Level 2 - usually used for departments or faculty within a larger unit (Example: Technology Learning Centre> Information Services)
- Level 3
- Content Only

Top Navigation/Menu Items:
- Used for large groupings or categories of information in a site
- Appear on all pages in the site
- Maximum limit of approximately 85 characters (including spaces and the vertical bars separating the nav menus)
  - The number of menu items appearing depends on the number of characters used
  - Be clear and concise when writing menu titles

In addition to the core templates, the following specially designed templates are available:
- Events calendar
- Faculty & Staff Bios
- Photo Gallery (upon request)

In addition to the templates, users can choose from several layout options when placing content in the templates. Layouts include:
- One column
- One column with events or quick links
- One column with events and quick links
- Two columns
3. **Staging Website**

Integrated Web Services has created a website to help users visualize the templates and layouts as they plan their site. Please visit: [http://staging.uregina.ca/templates/index.html](http://staging.uregina.ca/templates/index.html). You can also refer to the “Web Template and Migration Guide Handbook.”

The staging site is also available for site owners as a publishing option during the design and development stages.

Web Template and Migration Guide Handbook
Chapter 3  Getting Started

1.   Location & Login

Integrated Web Services will create your site structure based on your completed Migration Guide. Then you will be able to access your working site on the staging site. To request a Migration Guide email IT.Support@uregina.ca

To access the Cascade Server:
   1.   Go to http://cascade.uregina.ca
   2.   Enter your Novell username and password, and select Login. If you have trouble with your login or to obtain a username and password, please contact IT.Support@uregina.ca
   3.   Remember to use the Log Out button in the upper right-hand corner of Cascade.

Note: Always use Mozilla Firefox browser when logging in to Cascade.
Chapter 4  Cascade Interface

Once you login Cascade’s dashboard will open. Below are commonly used areas when maintaining your website.

1. Sites Drop Down

If you have access to more than one site, you can access additional sites through the site drop down menu. If you need access to a site, please email the IT Support Centre at IT.Support@uregina.ca

To access site drop down:

![Site Drop Down]

2. Side Bar Toggle Icon

This icon works like an on/off switch. It shows and hides your site folders. Open the side bar when working with folders and hide the side bar when needing more space to work in single pages.

Turn on/off Side Bar Toggle:
3. **Base Folder List**

Your site has a number of pre-built folders: assets, events, and faculty-staff folders. Your website homepage is the index page located in the Base Folder.

**Items to remember:**
- Often these folders appear in the site top navigation.
- Each folder should contain an index page.
- The index file located in the base folder is the site’s homepage.

Below are examples of some folders:

<table>
<thead>
<tr>
<th>Base Folder</th>
<th>This folder is the main site folder and will contain an index page which is your site’s homepage.</th>
</tr>
</thead>
<tbody>
<tr>
<td>assets folder</td>
<td>This frequently used folder is a place to store documents and images.</td>
</tr>
<tr>
<td>events folder</td>
<td>This folder is used to add upcoming events to the site using the dynamic events template. The folder has many folders in it organized by year (2015) and then month (05 is May and so on).</td>
</tr>
<tr>
<td>faculty and staff</td>
<td>This folder holds bio pages for staff and faculty.</td>
</tr>
<tr>
<td>Parent folder</td>
<td>Folder chooser that allows the page to be stored anywhere within the folder hierarchy.</td>
</tr>
</tbody>
</table>
4. Reordering folders

The folders within the base folder may be reordered. The reordering of folders has a direct effect on your site's top navigation.

**To reorder folders in the Base Folder:**
1. Turn Side Bar on (see above).
2. Select the Base Folder in the left column.
3. A list of contents appears on the right side.
4. In the Actions column, use the Move to Top, Move Up, Move Down, Move to Bottom, Edit, or Delete Icons.
   OR
5. Place cursor in the order column and drag and drop folders as needed.

![Image of folder reordering](image)

5. Top Navigation Bar (Home, New, History, Tools)

This is a static tool bar that has commonly used commands. The New menu is used most frequently.

![Image of top navigation bar](image)
6. **Asset tabs (static)**

The asset or folder tabs change depending on what is selected. These folder tabs are discussed in detail throughout this handout.

![Folder Tabs Example](image)

7. **Secondary tabs (dynamic)**

Each tab may have secondary commands. For example: Select a folder, then the View tab. The secondary commands are Contents, Gallery, and Properties while on the edit tab the secondary commands are System and Metadata.

![Edit Tabs Example](image)
Chapter 5  New Pages

There are three basic categories of core templates. The main difference between the templates is the decreasing size of the image area. There is also a content only template which has no image area. Within each category there are several options. It is important to know what kind of template to use BEFORE creating a new page. To view these templates on the web, please visit: http://staging.uregina.ca/templates/index.html

- Level 1
- Level 2
- Level 3
- Content Only

A. Level 1

B. Level 2

C. Level 3
1. Creating a New Page

Items to remember:
- Which template should you use for the page?
- Page names are important.
- Keep System names in lower case with no spaces. Hyphens are recommended. Ex. blue-hills
- Do you want the page to show in top or side navigation?
- Images play an important role.
- Pages can appear on the left side menu.

When creating pages keep these definitions in mind:

**System name**
This is the name that is used in the URL address of the page. This name should be all lower case without any spaces or punctuation. Please use hyphens. Ex. computer-training

**Parent folder**
Folder chooser that allows the page to be stored anywhere within the folder hierarchy.

**Display name**
Name of the page; used for content reuse and navigation.

**Title**
Name of the page and displays as the title of the page within the content as a Heading 1. This is also the name which appears in the browser which is bookmarked and search engines find; so make the title meaningful.

**Banner Image**
Images that appear at the top of the page; must be in standard sizes.

To create a new page:
1. In the top Navigation bar, select New and the type of page you want (Ex. Home Page, Secondary Page, or Third Level Page).
2. Select the Parent Folder location for the page.
3. Enter System Name.
4. Enter the Display Name.
5. Enter the Title.
6. Select ‘Yes’ or ‘No’ to display in side Navigation.
7. Select a Banner Image. See Section – Changing Banner Images.
8. In each WYSIWYG enter department content.
   - Note: Depending on the chosen template, there may be more than one WYSIWYG requiring content.
9. Submit.
Chapter 6  The WYSIWYG

WYSIWYG stands for ‘What You See Is What You Get’. It is in the WYSIWYG box that content is entered. WYSIWYG’s appear anywhere there is a place to enter content. This box is used for common formatting such as font and alignment as well as more complex tasks such as inserting hyperlinks, pasting as plain text, and viewing the HTML code that is being created in the background.

Items to remember:

- This is where most content is entered.
- The WYSIWYG has many useful icons such as:
  - Paste as Plain Text
  - Headings
  - Full screen mode
  - Hyperlink
  - Anchors (covered in Level II)

1. Using the WYSIWYG

To use the WYSIWYG:

1. WYSIWYGs appear anywhere there is a place to enter content. Example – when creating a new page.
2. Select the text by highlighting it with your mouse and click on the appropriate icon.
3. If no text is selected, the format you apply (i.e. alignment, indentation, bulleting etc.) will be applied to all text that follows.

Most people are familiar with the some common icons like bullets or alignment. However there are some useful icons which will help when creating content.

- **Paste as Plain Text** is used when copying and pasting from other programs such as Microsoft Word. It helps keep your HTML code clean.
- **Insert/edit link & unlink** are used to connect text or graphics to another webpage or location.
- **Toggle Full Screen Mode** increases the WYSIWYG size for easier editing.
- **Edit HTML Source** allows you to look at the code which Cascade is creating in the background.
2. **Adding Hyperlinks**

To add a hyperlink:

1. While in the WYSIWYG select the text to link.
2. Select the hyperlink icon.
3. In the Insert/Edit link box:
   a. For internal links, select the paper icon to browse for within your site.
   b. For external links, type the URL including the http://
   c. Set target to Same Window or New Window
   d. Enter the Title for the link. This text appears when someone hovers over the link.
   e. Select Insert.

3. **Applying Headings**

Headings are a way to keep your pages looking consistent.

To apply a heading:

1. While in the WYSIWYG select the text you want formatted.
2. Select the Paragraph drop down box.
3. Choose the type of heading. Example Heading 1, Heading 2, and so on.
Chapter 7  Changing Banner Images

1.  Banner Images

The U of R Templates have a banner area at the top for images (except for the Content Only template). Each department may add or delete the images that appear in this space. Level 1 pages allow for multiple images which rotate. Please contact AV Services for assistance with image selection and sizing.

Users may also choose to create their own images and use a third party program like ‘Microsoft Office Picture Manager’ to size them. (See Level II training manual).

Below is an image sizing chart.

<table>
<thead>
<tr>
<th>Template</th>
<th>Image Size</th>
<th>Recommended Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level 1 (Home Page)</td>
<td>160 pixels by 800 pixels</td>
<td>72 dpi</td>
</tr>
<tr>
<td>Level 2 (Secondary Pages)</td>
<td>135 pixels by 800 pixels</td>
<td>72 dpi</td>
</tr>
<tr>
<td>Level 3 (Third Level Pages)</td>
<td>95 pixels by 800 pixels (single image is built from three smaller images; each is 260 pixels wide with 10 pixels white space between them)</td>
<td>72 dpi</td>
</tr>
</tbody>
</table>

2.  Home page Banner Slideshow

To change banner images:
1.  Make sure you have uploaded the image file to add to the banner.
2.  Select the page to edit.
3.  Select the Edit tab.
4.  The Slide Show Image/Banner Image is located in the Text area.
5.  To add an image, click on the plus sign:
   a.  Select the image icon to browse.
   b.  Once the image is selected, choose Confirm.
   c.  To view the image, select the Magnifying icon.
6.  To remove the image, click on the minus sign.
3. **Realize Statement**

The background of the Realize statement trapezoid is black; the lettering is white and one word is in color. The color for administrative unit websites is gold while faculties have a custom color. There is always a period after the word "Realize" followed by a supporting statement. These statements can be customized to reflect the values and goals of the faculty or unit.

If you require assistance developing your Realize statement, contact Communications (External Relations) at 585-4402. If you need assistance designing the actual .jpeg image to include your statement, contact Printing Services. (There will be a fee for the design service.) More information and some examples of Realize statements can be found in the Visual Identity Standards manual (UR home>Faculty&Staff> Visual Identity Standards Manual).
Chapter 8  Uploading Files & Creating Folders

1. Uploading Files

Before you link to a document on your website, the document must be uploaded. Multiple files can be zipped into a single file and uploaded.

Items to remember:
- If changing the system name, include file extension. For example, blue.pdf or red.doc
- You may also just leave the System and Display name as ‘File’.

A. Upload a File: Drag and Drop

1. Click on the name of the folder in which you want the document to be placed. Example: doc, pdf, ppt, xls. These files should be stored within your assets folder under ‘docs’.
2. Then, select New, Defaults, File.
3. Enter a System Name including the file extension. Example: .doc .pdf
4. Enter Display Name if including in Navigation.
5. Choose ‘yes’ or ‘no’ to include the file in Navigation.
6. Drag and drop your file into the upload box.
7. Submit.
B. Upload a File: Browse

1. Click on the name of the folder in which you want the document to be placed. Example: doc, pdf, ppt, xls. These files should be stored within your assets folder under ‘docs’.
2. Then, select New, Defaults, File.
3. Enter a System Name including the file extension. Example: .doc .pdf
4. Enter Display Name if including in Navigation.
5. Choose ‘yes’ or ‘no’ to include the file in Navigation.
7. Once found, select open
8. Submit.

2. Creating Folders

Folders which are published appear in your website’s top or side navigation.

To add a folder:
1. Select New, Defaults, Folder.
2. Enter System Name.
3. Select the Parent Folder to store the link. Note: If you would like to add to your sites top navigation menu, select ‘Base Folder’.
4. Enter Display Name.
5. Enter Title.
6. Site Identifier is used if your site belongs to a larger site.
7. Select ‘yes’ or ‘no’ to include in the side Navigation and Top Navigation.
8. Submit.

Remember: Each folder should have an index page.

To move/ rename a folder:
1. Select the folder you would like to move.
2. Select the Move/Rename tab.
3. Change the System Name to rename the folder OR to move.
4. Click on the Parent Folder icon – this opens a pop-up window.
5. Choose the destination folder on the left side of the pop-up window
6. Select Confirm & Submit.

Remember: Publish your whole site when moving or renaming folders.
Chapter 9  Quick Links

There are two types of quick links: repeating and unique. Repeating quick links offer an entire folder or site to have the same quick link container appear each time a repeating quick link page is chosen. A unique quick link is for a single time use which is attached to a specific page.

1. Unique Quick Links

To add unique quick links:
1. In New, select a template which has unique quick links.
2. Enter page details as normal.
3. Enter a Quick Links Title.
4. Notice there is a second WYSIWYG with a Quick Links above.
5. Enter text.
6. Select text.
7. Select the add hyperlink icon in the WYSIWYG.
8. Hyperlink as before – See Hyperlinks section of this handout for more information.
   Note: This area is not limited to hyperlinks and can contain any kind of content – text, images, icons, etc.
9. This type of quick link only applies to the page in which the links are placed.

2. Repeating Quick Links

Repeating quick links will have the same content appear, or repeat, on all pages where a FOLDER – QUICKLINKS container has been added into a folder and a repeating template has been chosen.

To add a FOLDER_QUICKLINK container:
1. New>Other>Folder-Quick Links Container.
2. Click on the new item called ‘Folder Quick Links Container’ that appears in your Folder list.
3. Select the Edit tab.
4. Add link names.
5. Select each link name.
6. Select each name and create the appropriate hyperlink. See Hyperlinks section of this handout for more information.
   Note: This area is not limited to hyperlinks and can contain any kind of content – text, images, icons, etc.
Chapter 10  Events

1.  Predefined Events Folder

Some templates have an event block. It is important to keep these events current if you choose to use this feature. Before creating an event, a Yearly folder must exist and events need to be created in the proper year and month folder. These folders and pages should not be deleted even if they are not in use. It is best to leave them unpublished. See Publishing Your Site – Chapter 14.

To add a yearly folder:
1.  Select the Events folder.
2.  Then select New, Events, and Yearly Folders.
3.  Enter the appropriate year in the System Name, Display Name, and Title. Example: 2015
4.  Parent Folder should be set to events.
5.  Select Submit.
6.  The result will be a yearly folder which contains 12 additional folders (01-12) which represent the months of the year. Do not alter folder names.

To create an event:
1.  Select the Events folder.
2.  Select the month within the correct yearly folder. For example it the event is on December 21, 2015 – Select Events>2015>12.
3.  Then select New, Events, Event.
4.  Enter the Display Name and Title for the event.
5.  Insert a Banner Image.
6.  Optional Author information could be added.
7.  The Expiration Date is required. The Expiration date is the date the event is no longer displayed.
8.  Enter Event Start Date, End Date, Time, and Location.
9.  Enter any other event information in the Content area.
10.  Submit.
December

Mon., Dec. 21, 2015 - Mon., Dec. 21, 2015 — General Student/Academic History

Chapter 11  Faculty-Staff Bio Pages

1. Predefined Faculty & Staff Folder

Integrated Web Services has created a Faculty/Staff folder and pages to set up and compile bio information. Individual bio pages can be added to the appropriate folder. Expanding the Faculty-Staff folder will show the pre-defined items. These folders and pages should not be deleted if they are not in use. It is best to leave them unpublished. See Publishing Your Site – Chapter 14.

To add individual bio pages:
1. Open the faculty-staff folder.
2. Select either the faculty folder or the staff folder before creating the bio page.
3. Go to New>Faculty-Staff Pages>Faculty Bio Page or Staff Bio Page.
4. Enter a system name with no spaces or punctuation. Example: joe_smith
5. At minimum, enter Display Name, First and Last Name.
6. To add a profile image:
   a. Select the Faculty Profile Image link.
   b. Select the Images folder in either the faculty or staff folder.
   c. Select Upload in the upper toolbar.
   d. Browse and select image – note size should be 100 pixels wide x 150 pixels high.
   e. An image preview will appear.
   f. Confirm.
   g. If no image is entered, the system will default to a U of R monogram in the image area.
7. Enter any additional bio information in the Main content WYSIWYG.
8. Submit.
Note: Recommended optimum profile size is 100px by 150px. If an image is not selected a University of Regina monogram will appear.

Jane Doe
Office Manager
Office: ED 548.3
Email: jane.doe@uregina.ca
Phone: 585-5658
Fax: 337-2425
Chapter 12  Email Forms

1.  Predefined Email Form

Cascade also has a pre-built email (contact) form which can be added to your site. The fields cannot be altered on this page. If needed, additional forms with different form fields can be built outside of Cascade using other software.

Note: When creating forms it is important to include the U of R disclaimer which is provided within the Cascade form template and describe the specific purpose of the information gathering of the form.

To add an email (contact) form:

1. Select New>Other>Email Form
2. Enter Display Name and Title.
3. Choose ‘yes’ or ‘no’ to Include form in Navigation.
4. Enter the Recipient Email. This is the email where the form will be sent.
5. Enter Form Identifier which is like a subject line of an email.
6. In Redirect After Submission, enter a URL for a page that tells the public that you have received the form and will respond in a timely manner.
7. In the Form Introduction WYSIWYG enter introductory remarks.
8. Any additional form elements could be added (xHTML code).
9. Submit.
Please contact a trainer regarding the Technology Learning Centre at IT.Support@uregina.ca and you will be assisted shortly.

Items indicated with an (*) are required.

* First Name

* Last Name

* E-mail Address

* Subject
Chapter 13  Correcting Mistakes

Items to remember:
Users may:
  o Delete a page or folder.
  o Restore a previous version.
  o Access the Recycle Bin.
  o Un-publish a page.

1. Deleting

When deleting assets it is recommended to publish the entire site to avoid orphaning files and pages.

To delete:
1. Select the item to delete in the folder list.
2. On the More tab, select Delete.
3. In addition, select the Un-publish Content check box.
4. Submit.
2. **Using Versions**

The last 20 versions of a page can also be reviewed or reactivated. This feature also indicates the last user to make a modification.

**To access versions:**
1. Select the item.
2. On the More tab, select Versions.
3. Old pages will be listed.
4. Select the desired version by clicking on the path name.
5. Select Activate to revive a previous version (don’t forget to re-publish).
   OR
   Compare with Current.

3. **Accessing the Recycle Bin**

If you accidentally delete a file by mistake, you can restore the file in the recycle bin. The recycle bin saves for 15 days.

**To access the recycle bin:**
1. Select Home.
2. Select the Recycle Bin tab.
3. Select the file to restore.
4. In the drop down menu choose Restore.
5. The file will be restored to its original location.
Chapter 14  Publishing Your Site

Publishing a website means to make the website available to the public online. Not all pages created need to be published.

Items to remember:
- There are two destinations to publish your site to:
  - ‘Production’ which is live to the public.
  - ‘Staging’ which is not accessible to the public.
- It is strongly recommended to publish the whole site rather than a single page to prevent orphaned files.
- Some employees may have different publishing access.

1. Publishing whole site

To publish or UN-publish a whole website:
1. Select the Base Folder in the folder list.
2. Select the Edit tab.
3. Ensure Publish and Index are selected to publish or deselected to UN-publish.
4. Then, select the Publish tab.
5. Select the destination you want to publish to.
Remember: Production is live to the public while Staging is a development site which can be used while reviewing and revising pages before they go live.
6. Select the Publish Mode: Publish or Un-publish.
7. Submit.
Chapter 15  Other

1. Google Analytics

If you would like more in-depth analytics data, please contact IT.Support@uregina.ca to be set up with a Google Analytics account.

For more information on using Google analytics, please visit: http://www.google.com/analytics/
2. **Copyright**

The University of Regina’s [Use of Copyright Materials Policy](#) outlines the position of the University on the use of Copyright Materials and the responsibilities of faculty and staff that make use of Copyright Materials in all forms. This policy outlines the position of the University on the use of Copyright Materials and the responsibilities of faculty and staff that make use of Copyright Materials in all forms.

Copyright infringement is a serious offence that may result in significant legal and financial ramifications for the University. This policy is intended to limit the potential liability of the University and its faculty and staff for copyright infringement through the exercise of due diligence in the use of Copyright Materials.

*University of Regina’s Photographic Collection*

The Photography department provides photography services for the University. Copyright clearances for those photographs are obtained for specific purposes. Anyone wishing to use photographs from the university collection should contact Photography at 306-585-4473 or email Trevor.Hopkin@uregina.ca.

Unless permitted by a specific license or other contract, or an exception under *the Copyright Act* through user rights, use or reproduction of Copyright Materials, in whole or in part, by any means, is not allowed without the permission of the copyright owner.

For general inquiries or specific questions concerning copyright, contact Christina Winter, Copyright Officer, at christina.winter@uregina.ca or 306-585-4642.
Chapter 16  Getting Help

Please forward any requests for assistance or action on an IT issue to the IT.Support@uregina.ca. If they cannot answer your question, they will enter a ticket on your behalf to another area within Information Services such as Integrated Web Services.